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Chapter 484

Superiority by a
Margin Tests for Two
Means in a ClusterRandomized Design
Introduction
This procedure computes power and sample size for superiority by a margin tests in cluster-randomized designs
in which the outcome is a continuous normal random variable.
Cluster-randomized designs are those in which whole clusters of subjects (classes, hospitals, communities, etc.)
are put into the treatment group or the control group. In this case, the means of two groups, made up of Ki clusters
of Mij individuals each, are to be tested using a modified z test, or t-test, in which the clusters are treated as
subjects. Generally speaking, the larger the cluster sizes and the higher the correlation among subjects within the
same cluster, the larger will be the overall sample size necessary to detect an effect with the same power.
It should be noted that we could not find any published results about superiority testing with cluster-randomized
designs. What we could find were Schuirmann’s TOST procedure and a discussion of how to adjust the t-test
sample size results given by Campbell and Walters (2014). So, we applied the Campbell and Walters adjustment
to Schuirmann’s test. We look forward to results that substantiate our approach.

The Statistical Hypotheses
Superiority tests are examples of directional (one-sided) tests. This program module provides the input and output
in formats that are convenient for these types of tests. This section will review the specifics of superiority testing.
Remember that in the usual t-test setting, the null (H0) and alternative (Ha) hypotheses for one-sided tests are
defined as follows, assuming that 𝛿𝛿 = 𝜇𝜇1 − 𝜇𝜇2 is to be tested.
𝐻𝐻0 : 𝛿𝛿 ≤ 0 versus. 𝐻𝐻𝑎𝑎 : 𝛿𝛿 > 0

Rejecting this test implies that the mean difference is larger than the value δ. This test is called an upper-tailed
test because it is rejected in samples in which the difference between the sample means is larger than D.
Following is an example of a lower-tailed test.
𝐻𝐻0 : 𝛿𝛿 ≥ 0 versus. 𝐻𝐻𝑎𝑎 : 𝛿𝛿 < 0

Superiority tests are special cases of the above directional tests. It will be convenient to adopt the following
specialized notation for the discussion of these tests.
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Parameter

µ1

PASS Input/Output Interpretation
Not used
Mean of population 1. Population 1 is assumed to consist of those who
have received the new treatment.

µ2

Not used

Mean of population 2. Population 2 is assumed to consist of those who
have received the reference treatment.

ε

SM

Margin of superiority. This is a tolerance value that defines the
magnitude of the amount that is not of practical importance. This may be
thought of as the smallest change from the baseline that is considered to
be different.

δ

δ

True difference. This is the value of µ1 − µ2 , the difference between the
means.

Note that the actual values of µ1 and µ2 are not needed. Only their difference is needed for power and sample
size calculations.

Superiority Tests
A non-inferiority test tests that the treatment mean is not worse than the reference mean by more than the noninferiority margin. The actual direction of the hypothesis depends on the response variable being studied.

Case 1: High Values Good, Superiority Test
In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the treatment mean is no less than a small amount below the reference mean. The value of δ must be greater than
ε. The following are equivalent sets of hypotheses.
𝐻𝐻0 : 𝛿𝛿 ≤ ε versus 𝐻𝐻𝑎𝑎 : 𝛿𝛿 > ε, ε > 0

𝐻𝐻0 : 𝜇𝜇1 − 𝜇𝜇2 ≤ ε versus 𝐻𝐻𝑎𝑎 : 𝜇𝜇1 − 𝜇𝜇2 > ε, ε > 0

𝐻𝐻0 : 𝜇𝜇1 ≤ 𝜇𝜇2 + ε versus 𝐻𝐻𝑎𝑎 : 𝜇𝜇1 > 𝜇𝜇2 + ε, ε > 0

Case 2: High Values Bad, Superiority Test
In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the treatment mean is less than the reference mean by at least the margin of superiority. The value of δ must be
less than -|ε|. The following are equivalent sets of hypotheses.
𝐻𝐻0 : 𝛿𝛿 ≥ −ε versus 𝐻𝐻𝑎𝑎 : 𝛿𝛿 < −ε, ε > 0

𝐻𝐻0 : 𝜇𝜇1 − 𝜇𝜇2 ≥ −ε versus 𝐻𝐻𝑎𝑎 : 𝜇𝜇1 − 𝜇𝜇2 < −ε, ε > 0
𝐻𝐻0 : 𝜇𝜇1 ≥ 𝜇𝜇2 − ε versus 𝐻𝐻𝑎𝑎 : 𝜇𝜇1 < 𝜇𝜇2 − ε, ε > 0
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Technical Details
Our formulation is a combination of superiority formulas given by Chow et al. (2003) pages 57-59 and the
cluster-randomized design formulas given in Campbell and Walters (2014) and Ahn, Heo, and Zhang (2015).
Denote an observation by Yijk where i = 1, 2 gives the group, j = 1,2,…,Ki gives the cluster within group i, and k = 1,
2, …, mij denotes an individual in cluster j of group i.
2
2
2
+ 𝜎𝜎𝑊𝑊𝑊𝑊𝑊𝑊ℎ𝑖𝑖𝑖𝑖
, where 𝜎𝜎𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵
is the variation between clusters
We let 𝜎𝜎 2 denote the variance of Yijk, which is 𝜎𝜎𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵
2
and 𝜎𝜎𝑊𝑊𝑊𝑊𝑊𝑊ℎ𝑖𝑖𝑖𝑖 is the variation within clusters. Also, let 𝜌𝜌 denote the intracluster correlation coefficient (ICC) which is
2
2
2
/�𝜎𝜎𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵
+ 𝜎𝜎𝑊𝑊𝑊𝑊𝑊𝑊ℎ𝑖𝑖𝑖𝑖
𝜎𝜎𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵
�. This correlation is the simply correlation between any two observations in the
same cluster.

For sample size calculation, we assume that the mij are distributed with a mean cluster size of Mi and a coefficient of
variation cluster sizes of COV. The variance of the two group means, 𝑌𝑌�𝑖𝑖 , are approximated by
𝑉𝑉𝑖𝑖 =

𝜎𝜎 2 (𝐷𝐷𝐷𝐷𝑖𝑖 )(𝑅𝑅𝑅𝑅𝑖𝑖 )
𝐾𝐾𝑖𝑖 𝑀𝑀𝑖𝑖

𝐷𝐷𝐷𝐷𝑖𝑖 = 1 + (𝑀𝑀𝑖𝑖 − 1)𝜌𝜌

𝑅𝑅𝑅𝑅𝑖𝑖 =

1
1 − (𝐶𝐶𝐶𝐶𝐶𝐶)2 𝜆𝜆𝑖𝑖 (1 − 𝜆𝜆𝑖𝑖 )

𝜆𝜆𝑖𝑖 = 𝑀𝑀𝑖𝑖 𝜌𝜌/(𝑀𝑀𝑖𝑖 𝜌𝜌 + 1 − 𝜌𝜌)

DE is called the Design Effect and RE is the Relative Efficiency of unequal to equal cluster sizes. Both are greater
than or equal to one, so both inflate the variance.
Assume that 𝛿𝛿 = 𝜇𝜇1 − 𝜇𝜇2 is to be tested using a modified two-sample t-test. Assuming that higher values are better,
the non-inferiority test statistic is
𝑡𝑡 =

𝑌𝑌�1 − 𝑌𝑌�2 − 𝜀𝜀
�𝑉𝑉�1 + 𝑉𝑉�2

We assume this statistic has an approximate t distribution with degrees of freedom 𝐷𝐷𝐷𝐷 = 𝐾𝐾1 𝑀𝑀1 + 𝐾𝐾2 𝑀𝑀2 − 2 for a
subject-level analysis or K1 + K2 – 2 for a cluster-level analysis.
Define the noncentrality parameter as Δ = (𝛿𝛿 − 𝜀𝜀)/𝜎𝜎𝑑𝑑 , where 𝜎𝜎𝑑𝑑 = �𝑉𝑉1 +𝑉𝑉2. We can define the critical value
based on a central t-distribution with DF degrees of freedom as follows.
𝑋𝑋 = 𝑡𝑡𝛼𝛼,𝐷𝐷𝐷𝐷

The power can be found from the following to probabilities

Power = 1 − 𝐻𝐻𝑋𝑋,𝐷𝐷𝐷𝐷,Δ

where 𝐻𝐻𝑋𝑋,𝐷𝐷𝐷𝐷,Δ is the cumulative probability distribution of the noncentral-t distribution.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are δ, Power, K1, and M1.
Under most situations, you will select either Power to calculate power or K1 to calculate the number of clusters.
Occasionally, you may want to fix the number of clusters and find the necessary cluster size.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found.

Test
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The
choice here determines the direction of the non-inferiority test.
If Higher Means Are Better the null hypothesis is δ ≤ SM and the alternative hypothesis is δ > SM. If Higher
Means Are Worse the null hypothesis is δ ≥ -SM and the alternative hypothesis is δ < -SM.
Test Statistic
Specify which t-test statistic you are going to use: a t-test based on the number of subjects or a t-test in which the
cluster means are treated as subjects.
T-Test Based on Number of Subjects
This uses the methodology shown in the recent books by Campbell and Walters (2014) and Ahn, Heo, and Zhang
(2015). In this case, power is based on a t-test in which the variance is inflated to adjust for the clustering and the
degrees of freedom is based on to the number of subjects.
T-Test Based on Number of Clusters
This uses the original methodology of Donner and Klar (1996). In this case, power is based on a t-test in which
the variance is also inflated to adjust for the clustering, but the degrees of freedom are based on the number of
clusters. Donner and Klar ignored the impact of COV, so, if you want to match their results, you should set the
COV to zero.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
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Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.025 is used for alpha of one-sided test and this has
become a standard.
You may enter a range of values such as 0.025 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Number of Clusters & Cluster Size
Group 1 (Treatment)
K1 (Number of Clusters)
Enter a value (or range of values) for the number of clusters in the treatment group. You may enter a range of
values such as 10 to 20 by 2. The sample size for this group is equal to the number of clusters times the average
cluster size.
M1 (Average Cluster Size)
This is the average number of subjects per cluster in group one. This value must be a positive number that is at
least one. You can use a list of values such as 100 150 200.

Group 2 (Control)
K2 (Number of Clusters)
This is the number of clusters in group two. This value must be a positive number. The sample size for this group
is equal to the number of clusters times the number of subjects per cluster.
If you simply want a multiple of the value for group one, you would enter the multiple followed by K1, with no
blanks. If you want to use K1 directly, you do not have to premultiply by 1. For example, all of the following are
valid entries:10 K1 2K1 0.5K1 K1.
You can use a list of values such as 10 20 30 or K1 2K1 3K1.
M2 (Average Cluster Size)
This is the average number of subjects per cluster in group two. This value must be at least one.
If you simply want a multiple of the value for group one, you would enter the multiple followed by M1, with no
blanks. If you want to use M1 directly, you do not have to premultiply by 1. For example, all of the following are
valid entries: 10M1 2M1 0.5M1 M1.
You can use a list of values such as 10 20 30 or M1 2M1 3M1.

Coefficient of Variation of Cluster Sizes
COV of Cluster Sizes
Enter the coefficient of variation of the cluster sizes (number of subjects). This value must be zero or a positive
number. The COV of X is defined as the standard deviation of X divided by the mean of X.
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Campbell and Walters (2014) page 71 give guidance on the possible values of COV. They indicate that as the
average cluster size increases, COV tends toward 0.65. They say that typical values of COV range from 0.4 to 0.9.
You can use a list of values such as 0.4 0.6 0.8.
Standard Deviation
The standard deviation, calculated by the sample formula (divide by n-1), is a measure of the variability. When no
other information is available, Campbell and Walters (2014) page 71 suggest using (Maximum Cluster Size Minimum Cluster Size) / 4.
All Cluster Sizes Equal
When all cluster sizes are equal, the coefficient of variation is zero.

Effect Size
SM (Superiority Margin)
This is the magnitude of the margin of superiority. It must be a positive number.
When higher means are better, this value is the shortest distance above the reference mean at which the treatment
mean is considered superior.
When higher means are worse, this value is the shortest distance below the reference mean at which the treatment
mean is considered superior.
δ (Mean Difference = μ1 – μ2)
This is the actual difference between the treatment group mean and the reference group mean.
When higher means are better, this value should be greater than SM.
When higher means are worse, this value should be negative and greater in magnitude than SM.
σ (Standard Deviation)
Enter the subject-to-subject standard deviation. This standard deviation applies for both groups.
Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7
9 or 1 to 9 by 2.
Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard deviation.
ρ

(Intracluster Correlation, ICC)

This is the value of the intracluster correlation coefficient. It may be interpreted as the correlation between any
two observations in the same cluster. It may also be thought of as the proportion of the variation in response that
can be accounted for by the between-cluster variation.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.05.
You may enter a single value or a list of values.
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Example 1 – Calculating Power
Suppose a superiority test is to be conducted on data obtained from a cluster-randomized design in which SM= 1;
δ = 2; σ = 4; ρ = 0.0, 0.05, and 0.10; M1 and M2 = 10; COV = 0.65; alpha = 0.025; and K1 and K2 = 20, 40, or 60.
Power is to be calculated assuming higher means are better.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for Two Means in a Cluster-Randomized Design procedure
window by expanding Means, then Two Independent Means, then clicking on Cluster-Randomized, and then
clicking on Superiority by a Margin Tests for Two Means in a Cluster-Randomized Design. You may then
make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better
Test Statistic ........................................... T-Test Based on Number of Subjects
Alpha ....................................................... 0.025
K1 (Number of Clusters) ......................... 20 40 60
M1 (Average Cluster Size) ..................... 10
K2 (Number of Clusters) ......................... K1
M2 (Average Cluster Size) ..................... M1
COV of Cluster Sizes .............................. 0.65
SM (Superiority Margin) .......................... 1
δ (Mean Difference) ................................ 2
σ (Standard Deviation) ........................... 4
ρ (Intracluster Correlation, ICC).............. 0.0 0.05 0.1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Test of H0: δ ≤ SM versus Ha: δ > SM
Higher Means are Better
Test Statistic: T-Test with DF based on number of subjects

Power
0.7033
0.9423
0.9911
0.5039
0.7973
0.9278
0.4018
0.6795
0.8440

Subj
Cnt
Gr 1
N1
200
400
600
200
400
600
200
400
600

Subj
Cnt
Gr 2
N2
200
400
600
200
400
600
200
400
600

Clus
Cnt
Gr 1
K1
20
40
60
20
40
60
20
40
60

Clus
Cnt
Gr 2
K2
20
40
60
20
40
60
20
40
60

Clus
Size
Gr 1
M1
10
10
10
10
10
10
10
10
10

Clus
Size
Gr 2
M2
10
10
10
10
10
10
10
10
10

COV
Clus
Sizes
COV
0.650
0.650
0.650
0.650
0.650
0.650
0.650
0.650
0.650

Diff
μ1-μ2
δ
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00

Superiority
Margin
SM
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Std
Dev
σ
4.00
4.00
4.00
4.00
4.00
4.00
4.00
4.00
4.00

ICC
ρ
0.000
0.000
0.000
0.050
0.050
0.050
0.100
0.100
0.100

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N1 and N2 are the number of subjects in groups 1 and 2, respectively.
K1 and K2 are the number of clusters in groups 1 and 2, respectively.
M1 and M2 are the average number of items (subjects) per cluster in groups 1 and 2, respectively.
SM is the superiority margin. Since higher means are better, this value is positive and is the distance above the group
two (reference) mean that is still considered superior.
COV is the coefficient of variation of the cluster sizes.
δ is the mean difference (μ1 - μ2) in the response at which the power is calculated.
σ is the standard deviation of the subject responses.
ρ (ICC) is the intracluster correlation.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.
Summary Statements
Sample sizes of 200 in group one and 200 in group two, which were obtained by sampling 20
clusters with an average of 10 subjects each in group one and 20 clusters with an average of 10
subjects each in group two, achieve 70% power to detect superiority. The margin of superiority
is 1.00. The true difference between the means is assumed to be 2.00. The standard deviation of
subjects is 4.00. The intracluster correlation coefficient is 0.000. The coefficient of
variation of cluster sizes is 0.650. A one-sided, two-sample t-test was used with a
significance level of 0.025. This test used degrees of freedom based on the number of subjects.

This report shows the power for each of the scenarios.

Plots Section

These plots show the results of the various scenarios specified.
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Example 2 – Validation using Another PASS Procedure
We could not find a validation example for this procedure, so we will compare the results with those of the
Superiority by a Margin Tests for Two Means using Differences procedure. The results should be identical when
M1 = M2 = 1. Use the following scenario: find K1 when δ = 2, SM = 1, σ = 3, alpha = 0.025, and power = 0.90.
That procedure obtained a value of 191 for K1 and K2.
Because M1 = 1, the values of ρ and COV are set to 0.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for Two Means in a Cluster-Randomized Design procedure
window by expanding Means, then Two Independent Means, then clicking on Cluster-Randomized, and then
clicking on Superiority by a Margin Tests for Two Means in a Cluster-Randomized Design. You may then
make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ K1 (Number of Clusters)
Higher Means Are ................................... Better
Test Statistic ........................................... T-Test Based on Number of Subjects
Power ...................................................... 0.90
Alpha ....................................................... 0.025
M1 (Average Cluster Size) ..................... 1
K2 (Number of Clusters) ......................... K1
M2 (Average Cluster Size) ..................... M1
COV of Cluster Sizes .............................. 0
SM (Superiority Margin) .......................... 1
δ (Mean Difference) ................................ 2
σ (Standard Deviation) ........................... 3
ρ (Intracluster Correlation, ICC).............. 0

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Test of H0: δ ≤ SM versus Ha: δ > SM
Higher Means are Better
Test Statistic: T-Test with DF based on number of subjects

Power
0.9013

Subj
Cnt
Gr 1
N1
191

Subj
Cnt
Gr 2
N2
191

Clus
Cnt
Gr 1
K1
191

Clus
Cnt
Gr 2
K2
191

Clus
Size
Gr 1
M1
1

Clus
Size
Gr 2
M2
1

COV
Clus
Sizes
COV
0.000

Diff
μ1-μ2
δ
2.00

Superiority
Margin
SM
1.00

Std
Dev
σ
3.00

ICC
ρ
0.000

Alpha
0.025

PASS also calculates K1 to be 191.
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